Contents

Using the tools on the Home page.................................................................1
  Overview of Home page features............................................................1
  How do I change the email address for my Web site's contact form?........2

Adding new folders and pages.................................................................3
  What is the difference between a folder and a page?.........................3
  How do I add a folder?.................................................................4
  How do I add a page?.......................................................................5

Adding site content.................................................................................6
  What are the differences between an article, news item, and press release?6
  How do I add an article?..............................................................7
  How do I add a news item?............................................................8
  How do I add an RSS feed?.........................................................9
  How do I add a press release?......................................................10
  How do I add a job opening?........................................................11
  How do I add an event?................................................................12

Editing or deleting site content.............................................................13
  How do I edit existing content?.......................................................13
  How do I delete existing content?..................................................14
  How do I re-arrange the order of folders or pages?.........................15

Editing practice areas and attorneys.....................................................16
  How do I add or remove an attorney or practice area?......................16
  How do I edit attorney details?.....................................................17
  How do I reorder the attorney list?................................................18
  How do I hide an attorney's name on my published site?...............19
  How do I edit practice area details?..............................................20
  How do I hide a practice area on my published site?.......................21

Editing text.........................................................................................22
  Toolbars, Links, and Buttons............................................................22
  How do I add an image?..............................................................29
  How do I add a video?.................................................................30
  How do I link to another page on my site?......................................31
  How do I link to another Web site or email address?......................32
  How do I link to a PDF or Microsoft Word document?..................33
  How do I copy and paste content created in Microsoft Word?........34
  How do I copy and paste content from another Web site?.............35
  How do I re-arrange the order of folders or pages?.......................36

Selecting themes, fonts, and colors.......................................................37
  How do I select a site template?....................................................37
  How do I change the color scheme for my site?..............................38
  How do I change the font on my site?..........................................39

Creating and publishing translations....................................................40
  Translations overview....................................................................40
  How do I add a new language to my site?......................................41
  How do I enter translations?........................................................42
  How do I hide an entire language on my published site?.............43
  How do I delete an entire language from my published site?.........44
Using the tools on the Home page

Overview of Home page features

The Home page offers quick access to information about your Web site and tools to help you create content. To go to the Home page at any time, click the Home tab. From the Home page:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine the status of your site</td>
<td>Look at the Status information in the Site Information area.</td>
</tr>
<tr>
<td>View your Web site in its current, published form</td>
<td>Click the Site link in the Site Information area.</td>
</tr>
</tbody>
</table>
| View a preview of changes you've made to your Web site | Click either of these links:
  - Update/View Preview Site in the Site Information area
  - Preview site in the Edit Your Site area |
| Change the email address for your site's customer contact form | Click the Edit link next to My email in the Site Information area. For more information, see How do I change the email address for my Web site's contact form? |
| Access your Lawyer HomePage email      | Click the WebEmail link in the upper right corner of the page.           |
|                                        | See the Lawyer HomePage email help for more information about this product.|
| Determine what you've changed and when the last changes were made | Review the information in the What Have I Customized? area. Click the links to switch to the Edit Content tab. |
| Add content to your site               | Click any of the links in the Create New Content area. For more information, see the detailed instructions below: |
|                                        | - Publish legal articles from your firm                                   |
|                                        | - Add your firm's recently issued press releases                         |
|                                        | - Post news items that might interest potential clients                 |
|                                        | - Incorporate external content by adding an RSS feed                     |
How do I change the email address for my Web site's contact form?

When visitors complete the "Email Us" or "Quick Contact" form on your Web site, the results are delivered to an email address. An email address for this form is imported automatically from the Martindale-Hubbell® Client Service Center (CSC), but you can enter a new address by following the steps below.

1. Click the Home tab.

2. Click the Edit link next to My email in the Site Information area.

3. Enter a new address in the Email Address box. To deliver contact information to multiple email addresses simultaneously, enter multiple email addresses separated by semicolons (;).

4. Click Save.
Adding new folders and pages

What is the difference between a folder and a page?

A folder is a navigational element, while a page contains content. If you create a folder, it will appear in your site's navigation area, but users will not be able to click it. Users can, however, click a page that you add under a folder. For example, in your site's navigation area, "Firm Information" is a non-clickable folder that contains the clickable page, "Attorneys".

You can only add folders to the top-level navigation on your site (sub-folders are not permitted), but you can add pages to any folder.

Tip:
For a more user-friendly site, only add pages or folders if the content you want to add doesn't belong under any of the default, automatically created content areas.
How do I add a folder?

Follow the steps below to add a folder to the top-level navigation for your site. Since folders do not contain any content themselves, you'll also create a page under the new folder.

**Tip:** For a more user-friendly site, only add pages or folders if the content you want to add doesn't belong under any of the default, automatically created content areas.

1. Click the **Edit Content** tab.
2. Click the **Create Folder** link in the **Create New Content** area.
3. Enter a name for the folder (the text that will appear in your site's navigation area), then click **OK**.
4. Enter a title for a new page to appear under the new folder, then click **OK**.

The page automatically refreshes, and your new folder and page appear at the end of the site navigation. You may want to edit the new page, add more pages to the folder, or re-arrange the site navigation.
How do I add a page?

Follow the steps below to add a new page to your site. The new page will be added at the end of the folder that is currently open.

**Tip:**
For a more user-friendly site, only add pages or folders if the content you want to add doesn't belong under any of the default, automatically created content areas.

1. Click the **Edit Content** tab.

2. Go to the folder in which you want to add a new page. For example, if you want to add a new page in the **Firm Info** folder, click an existing page under that folder to set your location.

3. Click the **Add New Page** link in the **Create New Content** area.

4. Enter a title for the page, then click **OK**.

The screen automatically refreshes, and your new page appears at the end of the folder you selected. You may want to edit the new page or re-arrange the page's location in the folder.
Adding site content

What are the differences between an article, news item, and press release?

An article is usually written by an attorney at your firm for a particular journal or other professional publication. Adding copies of these articles to your site shows your firm’s expertise and leadership in your areas of practice.

A press release is information that was written by your firm for publication in multiple sources, such as local newspapers. For example, press releases may highlight achievements or awards that attorneys at your firm have received.

News is a broader category that may include your firm’s newsletters or syndicated news related to your practice areas.
How do I add an article?

When you add your first article, an Articles page is created automatically under the Publications folder. The Articles page contains links to all of your articles, with the newest ones listed first. The Articles page also displays abstracts for each article, if you provide them.

To add an article to your site:

1. Click the **Edit Content** tab.
2. Click the **Add Article** link in the **Create New Content** area.
3. Enter a title for the article, then click **OK**. The page refreshes automatically.
4. Edit the article contents, clicking the **Edit Text** and associated **Accept** buttons if desired, then click **Save** when you are finished.

The article page refreshes automatically, and the information you entered appears. You must publish your changes to make the new article visible on your site.
How do I add a news item?

When you add your first news item, a Company News page is created automatically under the News folder. This page contains links to all of your news items, with the newest ones listed first. The Company News page also displays abstracts for each item, if you provide them.

To add a news item to your site:

1. Click the **Edit Content** tab.
2. Click the **Add News Item** link in the **Create New Content** area.
3. Enter a title for the news item, then click **OK**. The page refreshes automatically.
4. Edit the news item's contents, then click **Save** when you are finished.

The Company News page refreshes automatically, and the information you entered appears. You must publish your changes to make the news item visible on your site.
How do I add an RSS feed?

An RSS feed is a stream of content that is generated by many popular news sites and blogs. You can incorporate an RSS feed into your Web site to make up-to-date content available at all times with only a one-time setup. For example, if your firm practices securities law, you may want to add RSS feeds to your site that contain top financial and business stories from a popular news organization. Some news providers even allow you to generate RSS feeds that contain stories matching keywords that you specify, such as "initial public offering".

Popular RSS feed providers include:

- Yahoo!
- CNN
- The Wall Street Journal
- Any other news site or blog that displays an RSS icon: 📰 or 📰

Note: Martindale-Hubbell does not endorse or support the sites listed above. These links are provided for information purposes only.

After you have identified an RSS feed, follow the steps below to add it to your site.

1. Click the Edit Content tab.
2. Click the Add RSS Feeds link in the Create New Content area.
3. Enter the URL for the RSS feed, then click OK. The page refreshes automatically.
4. Edit the attributes of the RSS feed contents, then click Save and Close when you are finished.

Tip: You can change the default "RSS Feeds" folder name to something that better describes the feeds you have added, such as "Recent Industry News". To change the folder name, click the Edit button that overlays the name.

Note: While you can change attributes like the number of stories that appear in the feed or the feed title, you cannot control which stories appear in the feed. Any story that is contained in the feed will be displayed automatically.

The RSS feed page refreshes automatically, and the contents of the feed are displayed with the settings you chose. You must publish your changes to make the feed visible on your site.
How do I add a press release?

When you add your first press release, a Press Releases page is created automatically under the News folder. This page contains links to all of your press releases, with the newest ones listed first. The Press Releases page also displays abstracts for each item, if you provide them.

To add a press release to your site:

1. Click the **Edit Content** tab.
2. Click the **Add Press Release** link in the **Create New Content** area.
3. Enter a title for the press release, then click **OK**. The page refreshes automatically.
4. Edit the press release's contents, then click **Save** when you are finished.

The Press Releases page refreshes automatically, and the information you entered appears. You must **publish your changes** to make the press release visible on your site.
How do I add a job opening?

The former Job Openings page is now a simple page, so follow the steps in How do I add a page?, and name the new page something appropriate to describe its purpose.
How do I add an event?

The former Events page is now a simple page, so follow the steps in How do I add a page?, and name the new page something appropriate to describe its purpose.
Editing or deleting site content

How do I edit existing content?

Much of the content for your site is automatically generated from the information you entered in the Martindale-Hubbell® Client Service Center (CSC). You can edit any of this information through Martindale-Hubbell® Lawyer Web Sites to change or further develop the details for your site.

1. Click the **Edit Content** tab.

2. Locate the information that you want to change.

3. Select the folder, article, or other item you want to edit from the **Site Pages** area on the left side of the page.

4. Change the item you selected. You can make small changes inline, taking advantage of the mini-formatting toolbar. Or you can make larger changes by clicking the **Edit Text** button and using the resulting window.

   **Tip:**
   
   If you click **Edit Text**, make sure you click the **Accept** button before closing that window, or you'll lose the changes you made.

5. Click **Save** when you have finished making changes.

You must **publish your changes** to make them visible on your site.
How do I delete existing content?

Caution: When you delete an item, it cannot be recovered. If you delete a folder or a page with sub-items (for example, a Company News page containing multiple news stories), any items they contain are also deleted.

Note: Attorneys and practice areas cannot be deleted through Martindale-Hubbell® Lawyer Web Sites because they are automatically generated from the information you entered in the Martindale-Hubbell® Client Service Center (CSC). However, you can hide attorneys or practice areas on your site.

To delete content from within an item:

1. Click the Edit Content tab.
2. Locate the information that you want to delete and click the Edit Text button in the mini-toolbar. The editor window opens.
3. Select and delete the text in the editor window.
4. Click Accept to confirm the change.

The editor window closes and the item you selected is deleted. You must save your changes and publish your changes to make them visible on your site.

To delete content from the Site Pages area (e.g., entire articles, folders, etc.):

Before You Begin: Not all items may be deleted in this way.

1. Click the Edit Content tab.
2. Locate the information that you want to delete in the Site Pages area on the left side of the page.
3. Right-click to display the shortcut menu.
4. Click Delete.
5. Click OK to confirm your desire to delete the item.

A confirmation window lets you know that the item was deleted successfully, and the page automatically refreshes. You must publish your changes to make them visible on your site.
How do I re-arrange the order of folders or pages?

To change the order of folders in your site's navigation area or to change the order of pages under a folder:

1. Click the **Edit Content** tab.
2. Select the content that you want to reorder in the Site Pages area to the left of the page.
3. Move the item:
   - Click the button for how you want to move the item using the options in the **Sort Item** area of the page (between the **Create New Content** and **Site Properties** areas).
   - Right-click, then choose how you want to move the item, then click **Yes** in response to the "Do you want to save the changes to the item?" question:
     - Sort Up
     - Sort Down
     - Sort First
   
   **Tip:** If you are moving a folder, note that the **Home** folder will always appear first in the navigation area. The highest you can move another folder is the second position.
     - Sort Last
4. Click **Save** when you are finished.

The page refreshes automatically, displaying your changes. You must publish your changes to make them visible on your site.
Editing practice areas and attorneys

How do I add or remove an attorney or practice area?

The lists of attorneys and practice areas on your site is automatically generated by the information that you entered into Martindale-Hubbell® Client Service Center (CSC). You cannot add an attorney or practice area to your site directly through Martindale-Hubbell® Lawyer Web Sites. However, you can edit existing practice areas or attorney biographies to develop the content further.

To add a new attorney or practice area, edit your firm’s information in the CSC. This information will automatically be added to your Web site.
How do I edit attorney details?

The attorney biographies on your site are generated automatically from the information that you entered into the Martindale-Hubbell® Client Service Center (CSC). You can also edit these biographies to develop them further.

**Note:**

When you manually edit attorney details in Martindale-Hubbell® Lawyer Web Sites, that attorney’s details will no longer be updated automatically if you make changes in the CSC. You can remove your manual updates and re-enable automatic updating at any time.

1. Click the **Edit Content** tab.
2. Click the name of the attorney whose details you want to edit under the **Attorneys** heading in the **Site Pages** area on the left side of the page.
3. Click into the area where you'd like to make a change. You can make a change by typing directly into an area or by clicking the **Edit Text** button on the mini-toolbar to open an editor window.
4. When you’ve finished editing the attorney biography, click **Save**.

The attorney biography refreshes automatically, and the information you entered appears. You must publish your changes to make them visible on your site.
How do I reorder the attorney list?

To change the order in which attorneys are listed on your Attorneys page:

1. Click the **Edit Content** tab.

2. Select the name of the attorney you want to reorder under the Firm Info folder.

3. Move the attorney:
   - Click the button for how you want to move the item using the options in the **Sort Item** area of the page (between the **Create New Content** and **Site Properties** areas).
   - Right-click, then choose how you want to move the item:
     - Sort Up
     - Sort Down
     - Sort First
     - Sort Last

   The attorney name is reordered as requested.

4. Click **Save** when you are finished.

The attorney list refreshes automatically, using the sort order you selected. You must publish your changes to update the sort order on your site.
How do I hide an attorney's name on my published site?

Since your list of attorneys is generated automatically from the information that you entered into the Martindale-Hubbell® Client Service Center (CSC), attorneys can only be deleted from the CSC. However, you can hide an attorney's name from your site without deleting it completely in the CSC.

1. Click the Edit Content tab.
2. Click the Attorneys page under the Firm Info folder in the Site Pages area of the page.
3. Right-click the name you want to hide, then click Page Properties from the menu.
4. Select the Hide Attorney check box, then click Save.
5. Click Save.

The attorney list refreshes automatically. The attorney's name still appears while you are viewing your site under the Edit Content tab, but it is hidden when you preview your site. You must publish your changes to hide the attorney's name on your site.
How do I edit practice area details?

The list of practice areas on your site is generated automatically from the information that you entered into the Martindale-Hubbell® Client Service Center (CSC). Through Martindale-Hubbell® Lawyer Web Sites, you can add details to these practice areas to develop them further.

1. Click the Edit Content tab.
2. Click the Practice Areas page under the Firm Info folder.
3. Click the practice area that you want to edit.
4. Use the provided fields to enter your information. You can enter text directly into each field, or use the mini-toolbar to make changes.
5. Click Save.

The practice area list refreshes automatically, and the information you entered appears. You must publish your changes to make them visible on your site.
How do I hide a practice area on my published site?

Since your list of practice areas is generated automatically from the information that you entered into the Martindale-Hubbell® Client Service Center (CSC), practice areas can only be deleted from the CSC. However, you can hide a practice area from your site without deleting it completely in the CSC.

1. Click the Edit Content tab.
2. Click the Practice Areas page under the Firm Information folder.
3. Right-click the practice area you want to hide, then click Page Properties from the menu.
4. Select the Hide Practice Area check box, then click Save.
5. Click Save.

The practice area list refreshes automatically. The practice area still appears while you are viewing your site under the Edit Content tab, but it is hidden when you preview your site. You must publish your changes to hide the practice area on your site.
Editing text

Toolbars, Links, and Buttons

The tables below explain the function of the buttons, links, and toolbars that are available for editing text.

- Create New Content area
- Sort Item area
- Button area
- Mini-toolbar
- Toolbar in the Edit Text window

Create New Content

<table>
<thead>
<tr>
<th>Link</th>
<th>Related Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Page</td>
<td>How do I add a page?</td>
</tr>
<tr>
<td>Create Folder</td>
<td>How do I add a folder?</td>
</tr>
<tr>
<td>Add RSS Feeds</td>
<td>How do I add an RSS feed?</td>
</tr>
<tr>
<td>Add Press Release</td>
<td>How do I add a press release?</td>
</tr>
<tr>
<td>Add Article</td>
<td>How do I add an article?</td>
</tr>
<tr>
<td>Add News Item</td>
<td>How do I add a news item?</td>
</tr>
</tbody>
</table>

Sort Item

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>First</td>
<td></td>
</tr>
<tr>
<td>Last</td>
<td></td>
</tr>
</tbody>
</table>

Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Properties</td>
<td>Opens a new window that lets you enter <strong>Firm Details</strong> (including <strong>Traffic</strong> and <strong>Latitude/Longitude</strong>) and <strong>Disclaimer</strong> text.</td>
</tr>
<tr>
<td>Page Properties</td>
<td>Opens a new window that lets you specify the following pieces of information:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Display Options</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>File Name</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Display Page check box</strong></td>
</tr>
</tbody>
</table>
### Button

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ Hide from Navigation check box</td>
<td>○ Display Client Review check box</td>
</tr>
<tr>
<td>○ Hide Attorney check box</td>
<td>○ Display Attorney Photo check box</td>
</tr>
<tr>
<td>○ Attorney Photo browse option</td>
<td></td>
</tr>
</tbody>
</table>

- **Meta Data/SEO**
  - ○ Title
  - ○ Description
  - ○ Keywords
  - ○ Custom Meta Tags
  - ○ Change Frequency
  - ○ Priority

- **Disclaimer**
  - ○ Enable State Disclaimer check box

<table>
<thead>
<tr>
<th>Preview</th>
<th>Opens a new window displaying your page as it will appear to your customers. (See How do I preview all unpublished changes on my site?)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves the changes you've made to your page.</td>
</tr>
<tr>
<td>Publish</td>
<td>Publishes all of the changes you've made to your page since the last time you clicked this button. (See How do I publish the changes I've made to my site?)</td>
</tr>
</tbody>
</table>

---

### Mini Toolbar

<table>
<thead>
<tr>
<th>Button/Icon/Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☰ Edit Text</td>
<td>Opens an edit text window with more editing controls.</td>
</tr>
<tr>
<td>B</td>
<td>Bold button - Applies bold formatting to selected text.</td>
</tr>
<tr>
<td>I</td>
<td>Italic button - Applies italic formatting to selected text.</td>
</tr>
<tr>
<td>▷</td>
<td>Increase Indent button - Moves paragraph indent to the right.</td>
</tr>
<tr>
<td>🌐</td>
<td>Insert Link icon - Opens the Insert a Link window that lets you link to internal items or media items.</td>
</tr>
<tr>
<td>⚡</td>
<td>Insert Image icon - Opens the Media Manager window that lets you choose or add a new image to insert into the text.</td>
</tr>
<tr>
<td>●</td>
<td>Changes the selected text to a bullet list.</td>
</tr>
<tr>
<td>Button/Icon/Link</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Center Alignment" /></td>
<td>Changes the alignment of the text where the cursor is to be centered.</td>
</tr>
<tr>
<td><img src="image" alt="Left Alignment" /></td>
<td>Changes the alignment of the text where the cursor is to the left.</td>
</tr>
</tbody>
</table>
| ![Hyperlink](image) | Opens the **Hyperlink** control that lets you enter a hyperlink URL for any of these types:  
  - (other)  
  - file:  
  - ftp:  
  - gopher:  
  - http:  
  - https:  
  - mailto:  
  - news:  
  - telnet:  
  - wais:  
  **Tip:** The link is inserted using the text of the hyperlink itself (e.g., http://www.lexisnexis.com), not using other words (e.g., the company). To insert a link using other words, use the ![Link](image) icon. |
| ![Undo](image) | Undo button - Reverses the last action. |

### Edit Text window

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Design Mode" /></td>
<td>Design button - Switches to Design Mode.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="HTML Mode" /></td>
<td>HTML button - Switches to HTML Mode.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Preview Mode" /></td>
<td>Preview button - Switches to Preview Mode.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Convert to Upper Case" /></td>
<td>Convert the text of the current selection to upper case, preserving the non-text elements such as images and tables.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Convert to Lower Case" /></td>
<td>Convert the text of the current selection to lower case, preserving the non-text elements such as images and tables.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Create Image Maps" /></td>
<td>Create image maps through dragging over the images and creating hyperlink areas of different shapes.</td>
<td></td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Description</strong></td>
<td><strong>Keyboard Shortcut</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------</td>
<td>----------------------</td>
</tr>
<tr>
<td><img src="image1" alt="Button" /></td>
<td>Insert and format code blocks into the content.</td>
<td></td>
</tr>
<tr>
<td><img src="image2" alt="Button" /></td>
<td>Apply to the current selection font size measured in pixels, rather than a fixed-size 1 to 7 (as does the FontSize tool).</td>
<td></td>
</tr>
<tr>
<td><img src="image3" alt="Button" /></td>
<td>Toggle Screen Mode - Switches to Full Screen Mode.</td>
<td></td>
</tr>
<tr>
<td><img src="image4" alt="Button" /></td>
<td>Show/Hide Border - Shows or hides borders around tables in the content area.</td>
<td></td>
</tr>
<tr>
<td><img src="image5" alt="Button" /></td>
<td>Zoom - Changes the level of text magnification.</td>
<td></td>
</tr>
<tr>
<td><img src="image6" alt="Button" /></td>
<td>Module Manager - Activates/deactivates modules from a drop-down list of available modules.</td>
<td></td>
</tr>
<tr>
<td><img src="image7" alt="Button" /></td>
<td>Toggle Docking - Docks all floating toolbars to their respective docking areas.</td>
<td></td>
</tr>
<tr>
<td><img src="image8" alt="Button" /></td>
<td>Repeat Last Command - A shortcut to repeat the last action performed.</td>
<td></td>
</tr>
<tr>
<td><img src="image9" alt="Button" /></td>
<td>Find and Replace - Find (and replace) text in the editor's content area.</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td><img src="image10" alt="Button" /></td>
<td>Print button - Prints the contents of the editor or the whole Web page.</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td><img src="image11" alt="Button" /></td>
<td>Spell button - Launches the spellchecker.</td>
<td></td>
</tr>
<tr>
<td><img src="image12" alt="Button" /></td>
<td>Cut button - Cuts the selected content and places it in the clipboard.</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td><img src="image13" alt="Button" /></td>
<td>Copy button - Copies the selected content to the clipboard.</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td><img src="image14" alt="Button" /></td>
<td>Paste button - Pastes the copied content from the clipboard into the editor.</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td><img src="image15" alt="Button" /></td>
<td>Paste from Word button - Pastes content copied from Word and removes the Web-unfriendly tags.</td>
<td></td>
</tr>
<tr>
<td><img src="image16" alt="Button" /></td>
<td>Paste from Word cleaning fonts and sizes button - cleans all Word-specific tags and removes font names and text sizes.</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Paste Plain Text button - Pastes plain text (no formatting) into the editor.</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Paste as HTML button - Pastes HTML code in the content area and keeps all the HTML tags.</td>
<td></td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Undo button - Reverses the last action.</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td><img src="image4.png" alt="Button" /></td>
<td>Redo button - Redoes/Repeats the last action, which has been undone.</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Format Stripper button - Removes custom or all formatting from selected text.</td>
<td></td>
</tr>
<tr>
<td><img src="image6.png" alt="Button" /></td>
<td>About Dialog - Shows the current version and credentials of editor.</td>
<td></td>
</tr>
</tbody>
</table>

**Insert and manage links, tables, special characters, images, and media**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7.png" alt="Button" /></td>
<td>Image Manager button - Inserts an image from a predefined image folders.</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td><img src="image8.png" alt="Button" /></td>
<td>Image map - Allows users to define clickable areas within an image.</td>
<td></td>
</tr>
<tr>
<td><img src="image9.png" alt="Button" /></td>
<td>Absolute Object Position button - Sets an absolute position of an object.</td>
<td></td>
</tr>
<tr>
<td><img src="image10.png" alt="Button" /></td>
<td>Insert Table button - Inserts a table in the editor.</td>
<td></td>
</tr>
<tr>
<td><img src="image11.png" alt="Button" /></td>
<td>Toggle Table Borders - Toggles borders on and off for all tables within the editor.</td>
<td></td>
</tr>
<tr>
<td><img src="image12.png" alt="Button" /></td>
<td>Insert Snippet - Inserts predefined code snippets.</td>
<td></td>
</tr>
<tr>
<td><img src="image13.png" alt="Button" /></td>
<td>Insert Form Element - Inserts a form element from a drop-down list with available elements.</td>
<td></td>
</tr>
<tr>
<td><img src="image14.png" alt="Button" /></td>
<td>Insert Date button - Inserts current date.</td>
<td></td>
</tr>
<tr>
<td><img src="image15.png" alt="Button" /></td>
<td>Insert Time button - Inserts current time.</td>
<td></td>
</tr>
<tr>
<td><img src="image16.png" alt="Button" /></td>
<td>Flash Manager button - Inserts a Flash animation and lets you set its properties.</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td><img src="image" alt="Windows Media Manager button" /></td>
<td>Windows Media Manager button - Inserts a Windows media object (AVI, MPEG, WAV, etc.) and lets you set its properties.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Document Manager button" /></td>
<td>Document Manager - Inserts a link to a document on the server (PDF, DOC, etc.)</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Hyperlink Manager button" /></td>
<td>Hyperlink Manager button - Makes the selected text or image a hyperlink.</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td><img src="image" alt="Remove Hyperlink button" /></td>
<td>Remove Hyperlink button - Removes the hyperlink from the selected text or image.</td>
<td>Ctrl+Shift+K</td>
</tr>
<tr>
<td><img src="image" alt="Insert Special Character button" /></td>
<td>Insert Special Character - Inserts a special character (€, ®, etc.)</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Insert Custom Link button" /></td>
<td>Insert Custom Link - Inserts an internal or external link from a predefined list.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Choose HTML Template button" /></td>
<td>Choose HTML Template - Applies an HTML template from a predefined list of templates.</td>
<td></td>
</tr>
</tbody>
</table>

**Create, format, and edit paragraphs and lines**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert New Paragraph button" /></td>
<td>Insert New Paragraph button - Inserts new paragraph.</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td><img src="image" alt="Paragraph Style Dropdown button" /></td>
<td>Paragraph Style Dropdown button - Applies standard text styles to selected text.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Decrease Indent button" /></td>
<td>Decrease Indent button - Moves paragraph indent to the left.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Increase Indent button" /></td>
<td>Increase Indent button - Moves paragraph indent to the right.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Align Left button" /></td>
<td>Align Left button - Aligns the selected paragraph to the left.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Center button" /></td>
<td>Center button - Aligns the selected paragraph to the center.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Align Right button" /></td>
<td>Align Right button - Aligns the selected paragraph to the right.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Justify button" /></td>
<td>Justify button - Justifies the selected paragraph.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Bulleted List button" /></td>
<td>Bulleted List button - Creates a bulleted list from the selection.</td>
<td></td>
</tr>
</tbody>
</table>
### Numbered List button
- Creates a numbered list from the selection.

### Insert horizontal line (e.g., horizontal rule) button
- Inserts a horizontal line at the cursor position.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Numbered List" /></td>
<td>Numbered List button - Creates a numbered list from the selection.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Insert Horizontal Line" /></td>
<td>Insert horizontal line (e.g., horizontal rule) button - Inserts a horizontal line at the cursor position.</td>
<td></td>
</tr>
</tbody>
</table>

## Create, format and edit text, font and lists

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Bold button - Applies bold formatting to selected text.</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td><img src="image" alt="Italic" /></td>
<td>Italic button - Applies italic formatting to selected text.</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td><img src="image" alt="Underline" /></td>
<td>Underline button - Applies underline formatting to selected text.</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td><img src="image" alt="Strikethrough" /></td>
<td>Strikethrough button - Applies strikethrough formatting to selected text.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Superscript" /></td>
<td>Superscript button - Makes a text superscript.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Subscript" /></td>
<td>Subscript button - Makes a text subscript.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Font Select" /></td>
<td>Font Select button - Sets the font typeface.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Font Size" /></td>
<td>Font Size button - Sets the font size.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Text Color" /></td>
<td>Text Color button - Changes the color of the selected text.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Text Color (background)" /></td>
<td>Text Color (background) button - Changes the background color of the selected text.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Custom Styles" /></td>
<td>Custom Styles - Applies custom, predefined styles to the selected text.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Insert Code" /></td>
<td>Insert and format code blocks into the content.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Custom Links" /></td>
<td>Custom Links - Inserts custom, predefined links.</td>
<td></td>
</tr>
</tbody>
</table>
How do I add an image?

Although you can add images to your site using the HTML view of the window that appears once you click Edit Text in the mini-toolbar, it's much easier to just click the image icon in the mini-toolbar.

To add an image using the mini-toolbar's icon:

1. Click the Edit Content tab.

2. Go to the item where you want to add an image. For example, if you want to add an image to a news item, click an item under the News folder to display its full text page.

3. Click the image icon in the mini-toolbar. The Media Manager appears in a new window.

4. Choose an image to insert using the My Media, Shared Media, or Upload Media buttons and their contents. The Media Manager lists all of the images you have uploaded previously and allows you to upload new ones. Any image that you add to your site must first be added to the Media Manager by following the steps below.

5. Do one of the following:

<table>
<thead>
<tr>
<th>If the image you want to add...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| Already appears in My Media     | a. Click the image to select it.  
|                                  | b. Click Insert.                 |
| Does not appear in My Media     | a. Click the Upload button.      
|                                  | b. Click the Browse button, locate the image file on your computer, then click Open. |
|                                  | c. Click Upload. Your image is added to My Media. |
|                                  | d. Click your image in the Media Browser to select it. |
|                                  | e. Click OK.                     |

The image you selected is added where your cursor was located when you clicked the Insert Image icon in the mini-toolbar.

6. Click Save.

You must publish your changes to make the image visible on your site.
How do I add a video?

**Before You Begin:**
Before you begin, find and copy the HTML code for a video on an external Web site. This code is generally found in a field named "embed", and it generally uses the `<object>` or `<iframe>` tag.

Example 1
```
<iframe height="339" width="425" src="http://www.msnbc.msn.com/id/22425001/vp/26856499#26856499" frameborder="0" scrolling="no"></iframe>
```

Example 2
```
<object width="425" height="344"><param name="movie" value="http://www.youtube.com/v/x62oix6QJnc&hl=en&fs=1"></param><param name="allowFullScreen" value="true"></param><embed src="http://www.youtube.com/v/x62oix6QJnc&hl=en&fs=1" type="application/x-shockwave-flash" allowfullscreen="true" width="425" height="344"></embed></object>
```

After you have copied the HTML code for a video, follow the steps below to add it to your site.

1. Click the **Edit Content** tab.
2. Go to the page where you want to add a video. For example, if you want to add a video to a news item, click a news item under **News > Company News** to display its full text page.
3. Paste the HTML code for the video into the [Enter Video tag] field.
4. Click **Save**.

Your video is added to the page. You must publish your changes to make the video visible on your site.
How do I link to another page on my site?

You can insert a hyperlink into the text of any field that uses the edit text window (such as the body of an article or a news item). These links can point to any page on your site or to an external site or an email address. To add a link to another page on your site:

1. Click the **Edit Content** tab.

2. Go to the item where you want to insert a link. For example, if you want to insert a link into an article, click an article under **Articles** under the Publications folder to display its full text page.

3. Select the text that you want to use for the link.

   **Tip:** Make your link names descriptive (e.g., "news page") instead of generic (e.g., "click here").

4. Click the **Insert Link** icon (🔗) in the mini-toolbar.

   **Note:** This is the first link button on the toolbar; the second is for linking to an external site. To ensure that you click the correct link button, rest your pointer on the button and verify that "Insert Link" appears.

5. Browse your site's hierarchy to locate the page you want to link to, then click the page to select it.

6. Click the **Link** button.

7. Click **Accept** to save your changes and close the editor window.

8. Click **Save**.

You must publish your changes to make the link visible on your site.
How do I link to another Web site or email address?

You can insert a hyperlink into the text of any field that uses the edit text window (such as the body of an article or a news item). These links can point to another site or email address or to any page on your site. To add a link to another site or an email address:

1. Click the Edit Content tab.
2. Go to the item where you want to insert a link. For example, if you want to insert a link into an article, click an article under Articles under the Publications folder to display its full text page.
3. Select the text that you want to use for the link.
   
   **Tip:**
   Make your link names descriptive (e.g., "news page") instead of generic (e.g., "click here").
4. Click the Insert Hyperlink icon (🔗) in the mini-toolbar.
5. Do one of the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to an external site</td>
<td>Enter or paste the address of the site in the URL box.</td>
</tr>
</tbody>
</table>
| Link to an email address | a. Select mailto: from the Type drop-down list.  
b. Enter the destination email address in the URL box. |

6. Click the OK button.

You must publish your changes to make the link visible on your site.
How do I link to a PDF or Microsoft Word document?

Instead of copying and pasting content from a Microsoft Word® or PDF document, you can import the document into Martindale-Hubbell® Lawyer Web Sites and then create a link to the document.

1. Click the **Edit Content** tab.

2. Go to the page where you want to insert a Word or PDF link. For example, if you want to link to a PDF copy of an article from the article body, click **Articles** under the News folder and then click the article to display its full text page.

3. Select the text that you want to use for the link.

   **Tip:** Make your link names descriptive (e.g., "original article text in PDF format") instead of generic (e.g., "click here").

4. Click the **InsertSitecoreLink** button (🔗).

   **Note:** This is the first link button on the toolbar; the second is for linking to an external site. To ensure that you click the correct link button, rest your pointer on the button and verify that "InsertSitecoreLink" appears.

5. Click the **Media Items** tab.

6. Click the **Upload** button.

7. Click the **Browse** button, locate the Word or PDF file on your computer, then click **Open**.

8. Click **Upload**. A pop-up window appears with the details of the file you uploaded.

9. Click the **Close** button to close the file details window.

10. Click your uploaded file in the Media Manager to select it.

11. Click **OK**.

12. Click the **Link** button. The text you selected in the editor window is linked to the document you uploaded.

13. Click **Accept** to save your changes and close the editor window.

14. Click **Save**.

You must **publish your changes** to make the document and link available on your site.
How do I copy and paste content created in Microsoft Word?

Before You Begin:
Before you begin, copy the content that you want to paste from a Microsoft Word® document. Then, follow the steps below to paste the content into a page on your site.

1. Click the Edit Content tab.
2. Go to the page where you want to paste text. For example, if you want to paste text into an article, click an article's title under Publications > Articles to display its full text page.
3. Click the Edit Text button for the item where you want to paste your copied text. The editor window opens.
4. Do one of the following:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste the text exactly as it appears in Word</td>
<td>Click the Paste from Word button (=W) or enter Ctrl+V</td>
</tr>
<tr>
<td>Paste the text, automatically changing fonts and sizes to match your site</td>
<td>Click the Paste from Word Cleaning Fonts and Sizes button (=W)</td>
</tr>
</tbody>
</table>

The text you copied is pasted into the editor window.

**Note:** Depending on your browser, a preview of your text may appear in a new window before it is added to the editor.

5. Click Accept to save your changes and close the editor window.
6. Click Save.

You must publish your changes to make them visible on your site.
How do I copy and paste content from another Web site?

Before You Begin: 

Before you begin, copy the HTML source code of the content that you want to paste from another Web site. (In most Web browsers, you can right-click a page and choose to view the page source.) Then, follow the steps below to paste the content into a page on your site.

Important:

Do not copy any copyrighted material from another site without the copyright holder’s permission.

1. Click the Edit Content tab.

2. Go to the page where you want to paste text. For example, if you want to paste text into an article, click an article’s title under Publications > Articles to display its full text page.

3. Click the Edit Text button for the item where you want to paste your copied text. The editor window opens.

4. Click the HTML button in the bottom, left corner of the edit text window.

5. Press Ctrl+V to paste the HTML code.

6. Click Accept to save your changes and close the editor window.

7. Click Save.

You must publish your changes to make them visible on your site.
How do I re-arrange the order of folders or pages?

To change the order of folders in your site's navigation area or to change the order of pages under a folder:

1. Click the **Edit Content** tab.

2. Select the content that you want to reorder in the Site Pages area to the left of the page.

3. Move the item:
   - Click the button for how you want to move the item using the options in the **Sort Item** area of the page (between the **Create New Content** and **Site Properties** areas).
   - Right-click, then choose how you want to move the item, then click **Yes** in response to the "Do you want to save the changes to the item?" question:
     - Sort Up
     - Sort Down
     - Sort First

   **Tip:** If you are moving a folder, note that the **Home** folder will always appear first in the navigation area. The highest you can move another folder is the second position.

   - Sort Last

4. Click **Save** when you are finished.

The page refreshes automatically, displaying your changes. You must **publish your changes** to make them visible on your site.
Selecting themes, fonts, and colors

How do I select a site template?

You can select from several predefined design templates for your site. These templates allow you to easily change your site's appearance and layout without affecting its content. To select a new site template:

1. Click the Choose a Design tab. Your current template appears in the top, left corner under Saved Design.

   **Note:** All of the templates shown under the Choose a Design tab are representative images only. They do not display customized information from your firm.

2. Use the arrows to the left and right of the sample templates to browse the available templates.

3. Click a new template to select it. The large template image at the bottom of the page changes to show the design you chose.

4. If desired, select a different color theme or font. See How do I change the color scheme for my site? or How do I change the font on my site? for more information.

5. Click Save Changes.

The tab refreshes automatically, and your new design appears in the top, left corner under Saved Design. You must publish your changes to make them visible on your site.
How do I change the color scheme for my site?

Each site template contains 3 predefined color themes. These themes allow you to quickly change the colors used on your site without affecting the layout or content. To change your site’s color theme:

1. Click the **Choose a Design** tab. Your current color theme and template appear in the top, left corner under **Saved Design**.

   **Note:**
   All of the templates shown under the Choose a Design tab are representative images only. They do not display customized information from your firm.

2. Click the **Color Theme** button. A menu of color theme options appears.

3. Click a new color theme to select it. The large template image at the bottom of the page changes to show the theme you chose.

4. Click **Save Changes**.

The tab refreshes automatically, and your new color theme appears in the top, left corner under **Saved Design**. You must **publish your changes** to make them visible on your site.
How do I change the font on my site?

You can choose one of several fonts to be used on your entire site. Changing your site's font does not affect its layout, colors, or content. To change your site's font:

1. Click the **Choose a Design** tab.

   **Note:**
   
   All of the templates shown under the Choose a Design tab are representative images only. They do not display customized information from your firm.

2. Click the **Font** button. A menu of font options appears.

3. Rest your pointer on any of the **View...** links to see a sample of a font.

4. Click a new font name to select it.

5. Click **Save Changes**.

The tab refreshes automatically. Your font selections are not reflected in the sample template images, but you can see the results by **previewing your site**. You must **publish your changes** to make them visible on your site.
Creating and publishing translations

Translations overview

You can translate your site into any of the following languages:

- French
- German
- Italian
- Portuguese
- Spanish

When you add a language to your site, Martindale-Hubbell® Lawyer Web Sites creates a copy of all of your site content in English, which you can translate into the new language. To avoid displaying incomplete translations on your site, you may want to hide a language from your site before publishing.

The Translations tab provides an overview of your translation status. For each language, it lists all of the folders and pages on your site and indicates their translation status:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No translation has been done</td>
</tr>
<tr>
<td></td>
<td>More work may be needed to complete the translation</td>
</tr>
<tr>
<td></td>
<td>The item has been fully translated</td>
</tr>
</tbody>
</table>
How do I add a new language to my site?

To add a new language:

1. Click the **Translations** tab.

2. Click the **Add or Remove Language** link.

3. Select a language from the **Available Languages** list, then click the **Add** button.

4. Click **Save**.

The language you selected is added. After you enter your translations for the new language, you must publish your changes to make them visible on your site.

**Note:**

The new language will become available on your site as soon as you publish. If you want to publish other changes before you have completed your translations, you may want to hide the language from your site.
How do I enter translations?

After you add a language to your site, you can enter translations for it. To enter translations:

1. Click the Translations tab.
2. Click the language you want to work on in the Your Site Languages area.
3. Click a translation link next to one of the folders or pages from your site. The Content Editor appears in a new window.
4. Enter your translations in each field.
5. Click Save/Close.

Your translations are saved. You must publish your changes to make them available on your site.
How do I hide an entire language on my published site?

If you hide a language, it will still be available to you under the Translations tab, but it will not be available for visitors to your site. It’s usually a good idea to hide a language until you have finished entering its translations. To hide a language:

1. Click the Translations tab.

2. At the top of the status table, click the Do not include link next to "Translations will be included on your published site". The Translation Status menu appears.

3. Select Do not include translations on the published site.

4. Click OK.

The language is hidden. You must publish your changes to remove the language from your published site.

When you are ready to make the language visible, repeat these steps but select Include translations on the published site from the Translation Status Menu.
How do I delete an entire language from my published site?

If you no longer want to offer a language on your site, you can delete it entirely. It will no longer be available to your users, and the language will no longer appear under the Translations tab. However, if you add the language again in the future, any translations you previously entered will still be available.

Tip:
You can also make a language unavailable by hiding it from your site instead of deleting it. For example, if you want to remove the language while you work on its translations, you should hide it instead of deleting it.

To delete an entire language from your site:

1. Click the Translations tab.
2. Click the Add or Remove Language link.
3. Select a language from the Your Site Languages list, then click the Remove button.
4. Click Save.
5. Click OK to confirm that you want to delete the language.

The language you selected is deleted. You must publish your changes to remove the language from your site.
Previewing and publishing changes

Publishing Overview

As you edit your site under the Edit Content tab, your changes are visible as soon as you save them. However, the content under this tab may not always reflect how your published site will look. For example, if you hide an item from your site’s navigation, it will still appear under the Edit Content tab so that you can return to it in the future.

By contrast, clicking the Preview site link on the Home page always displays the exact content and appearance of your site with your most up-to-date changes. You can review all of your changes before publishing.

Click the Publish icon on the Home page whenever you want to publish the changes you have made to the site that your visitors see.

Note: If you sign out of Martindale-Hubbell® Lawyer Web Sites without publishing, your changes will be saved until you return.
How do I preview all unpublished changes on my site?

To preview the exact content and appearance of your site with your most up-to-date changes, click the **Preview site** link in the **Edit Your Site** area of the Home page. After you have browsed your site under this tab, you may want to publish your changes.
How do I publish the changes I've made to my site?

When you make any change to your site, they are not available to your site's visitors until you click the Publish icon on the Home page.

**Note:**

When you publish your changes, all changes you have made are published at the same time. You may want to preview your changes before publishing.

To publish your site:

1. Click the **Publish** icon on the Home page.
2. Click **OK** to confirm that you want to publish your changes.

After the changes are processed, a message confirms that they were published successfully. To view your published site, click the **Home** tab, then click the **Preview Site** link in the **Edit Your Site** area.
Where did the content on my new Web site come from?

When your site was built, content was taken from your Martindale-Hubbell® Professional Biography. You can add more content to enhance your site's presence on the Web.
Are my changes linked to my Martindale-Hubbell® Professional Biography?

Changes to your Web site will not update your Professional Biography, and you cannot hide your Professional Biography data using Martindale-Hubbell® Lawyer Web Sites.

The only change to your Professional Biography that will update your Web site is when you add or remove attorneys from your firm using the Martindale-Hubbell® Client Service Center (CSC). These attorneys will automatically be added or removed from your Web site.
How can I drive traffic to my Web site?

The best way to drive traffic to your Web site is to build a robust site rich in content. Update your site frequently to keep your content fresh.

Martindale-Hubbell also offers additional services such as Search Engine Optimization and Pay-Per-Click advertising. Click the Customer Support link in the upper right corner of any Martindale-Hubbell® Lawyer Web Sites page to request more information about these offerings.
Additional Questions

How do I change the email address for my Web site's contact form?
How do I link to a PDF or Microsoft Word document?
How do I copy and paste content created in Microsoft Word?
How do I copy and paste content from another Web site?
How do I add an image?
How do I link to another page on my site?
How do I link to another Web site or email address?
How do I add or remove an attorney or practice area?
Contacting LexisNexis

To send a message to Customer Support, click the **Customer Support** link in the top navigation area and complete the contact form.

You can also use the contact information below. All Customer Support is available from 8:30 AM to 7:00 PM Eastern Time, Monday-Friday.

<table>
<thead>
<tr>
<th>Department</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Support</td>
<td>1-800-526-4902 Option 2</td>
<td><a href="mailto:websitesupport@lexisnexis.com">websitesupport@lexisnexis.com</a></td>
</tr>
</tbody>
</table>